
by Michael Meeks
General Manager

@michael_meeks michael.meeks@collabora.com 

The ongoing story of Online
How we got to here … & where to go ?

“Stand at the crossroads and look; ask for the 
ancient paths, ask where the good way is, and 

walk in it, and you will find rest for your souls...” - 
Jeremiah 6:16

mailto:michael.meeks@collabora.com


Online & LibreOffice – pre-history ...
StarPortal ~2000+ somewhen.

● ActiveX control – running in IE – talking to a Sun Server !

● Lots of UNO-ness to make it work, proprietary headless backend too.

May 2006 - Add vigra and supporting libs to OOo (i65904)

● Thorsten Behrens @ StarDivision → “The only client today is module basebmp, which provides a software rasterizer.”

●  27 files changed, 6078 insertions(+)
● Basebmp lasts a decade to Jan 2016 → Caolan re-wrote to Cairo; still there in Apache OpenOffice

June 2007 - make svp plugin opensource (i78931) - philipp.lohmann 

● “StarOffice has a headless plugin for the Unix versions, which we now
 want to relicense as LGPL to avoid duplicating efforts started by cmc.”

● Triggered by: vcl/unx/headless → started by Caolan @ RedHat (i76958)

● Adds basebmp and much more ... in VCL alone:

● 143 files changed, 12096 insertions(+), 388 deletions(-)

https://bz.apache.org/ooo/show_bug.cgi?id=65904
https://bz.apache.org/ooo/show_bug.cgi?id=78931
./(https://bz.apache.org/ooo/show_bug.cgi%3Fid=76958


Online & LibreOffice – created ...
September 2010 → announce the idea of TDF

October 2011 → Paris conference …

● Amazing amount of hackery from me @ SUSE to get
a first gtk3 port working … Cairo rendering,
damage tracking, clipping: a sample git commit:

“gtk3: extensive X-orcisms performed, with some horrendous cut/paste
         code looks like the wild-west, needs incremental cleanup & re-factoring”

● Demo to potential Gov’t investor → no taker.

The SUSE era !



1st LibreOffice conference
October 2011

My slides:



Cloud Office … technologies ...

Uses gtk+ 3's / broadway backend to render (via some 
javascript shims) in the browser:

All intelligence and rendering on the 'server' app.
broadway.js - < 3k LOC ...

Still a prototype
rendering performance improving, but lumpy in places.

This approach allows a full-feature experience
ie. complex text-layout, large, complex spreadsheets, 
WYSIWYG (eg. edit your footnotes on the page), VBA 
macros, Pivot Tables etc.



Example:
Custom contoured picture, 
with text fill

Does that look 
familiar ?



All text and image content in this document, unless otherwise specified, is licensed under the 
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It is a prototype … cannot deploy it today
basic (prototype) functionality will be in 3.5 (Feb.)
server resource usage is not yet optimal, no hosted slashdot-proof PoC …

Code is all in public git:
git clone git://anongit.freedesktop.org/libreoffice/core
git checkout feature/gtk3 ; configure ; make install
export GDK_BACKEND=broadway …

Firefox 4 (with websockets enabled): grab a FF sticker !
Thanks to Alex Laarson of RedHat for: gtk+ / broadway

LibreOffice On-Line conclusions ...

Quite possibly gtk+ broadway still works today.

http://creativecommons.org/licenses/by-sa/3.0/
https://docs.gtk.org/gtk3/broadway.html


Online & LibreOffice – TDF setup...
Feb 2012 → FOSDEM – shows gtk-broadway + Android hacks.

● Tor Lillqvist did much of the heavy-lifting work here.
● I was up incredibly late hacking together with Kendy

● night before - trying to get Android working ...

LibreOffice in a browser & on Android - pre-dates TDF ...

Feb 2012 → TDF founded The SUSE era ...



LibreOfficeKit ...
My vision:

● Make LibreOffice really easy to 
consume & re-use

● UNO great for scripting – not 
easy to re-use.

● A header-only C library – with 
C++ wrapper

Author: michael.meeks@suse.com

Date:   Tue Mar 5 13:16:36 2013 
+0000

    liblibo: create initial liblibreoffice.

Subsequently renamed to 
LibreOfficeKit

Used initially for ‘loconv’

● High-speed file-format conversion

● In-process, rather than remote-
UNO to manage soffice binary.

LibreOffice exposes magic entry point:

● libreofficekit_hook (_2) – we dlsym 
and pull it out.

mailto:michael.meeks@suse.com


FOSDEM: Feb 2012 ...



A glimpse into the future:

“In the future, Cloud computing will be the only choice”

“Successful businesses may soon have no chief 
executive, no headquarters, and no IT infrastructure”

The Telegraph inverviewing Nick Martindale

a FOSDEM 2012 slide ...

http://www.telegraph.co.uk/sponsored/technology/microsoft-cloud-computing/8667512/In-the-future-Cloud-Computing-will-be-the-only-choice.html


Not a terribly new idea:

“Every kingdom divided against itself will be ruined, 
and every city or household divided against itself 

will not stand” -Matthew 12 ~30AD



A design that re-uses code ...
Cut one feature to share the rest: the off-line web app

Help

Web UI Android / 
Handset UI

Traditional UI:
Linux/Mac/Win

ClipartUser 
Mgmt.
Sandbox

Templates Translations Impress

Calc
Writer

Database
Exotic filters

95% of code shared, most featureful is the web app !



Show me the code !
Shipping out of the box in LibreOffice 3.5

Work continues on master; -plenty- to fix.
To use a modern browser ie. v7 websockets

you need master gtk3+
or an update to openSUSE 12.1

Otherwise – that's it:
git clone git://anongit.freedesktop.org/libreoffice/core

Hacking help very much appreciated
Plenty of VCL/gtk3/rendering bugs

no browser required.



So far – font
rendering is a
challenge
Red to Orange
debug funkiness
comes by default !
Fonts – confused …
But – more
encouragingly
Tor has scads of
unit tests running ...



Online & LibreOffice – Collabora ...
Sep 2013 →  Collabora spun out of SUSE …

● Other teams suspect having too much fun mobile / web hackery ...

“Finally free! …
to do exactly what our customers want”

Oct 2013 → CloudOn signed up: “mobile support”

● CloudOn – brought Microsoft Office to the iPad etc. …
● When that went south: LibreOffice  !



Online & LibreOffice – Smoose ...
May 2014 → Smoose funds LibreOffice Viewer Application for Android

● Mozilla Fennec / LibreOfficeKit tiled rendering (cf. CloudOn)

● “SUSE provided a key foundation of cross-platform support, with Google Summer of 
Code contributions from Andrzej Hunt and Ian Billet, along with improvements from 
Igalia S.L., and core components by Mozilla Corporation.”



Online & LibreOffice – TDF ...
Dec 2014 → TDF funds Android Editing work (Eur 84k)

● A tender to: "develop the base framework for an Android version
of LibreOffice with basic editing capabilities".

● Extending LibreOfficeKit API – with editing events.

Jan 2015 → CloudOn acquired by DropBox & exits LibreOffice …



LibreOfficeKit – UI users ...
GNOME Documents …

● Viewing arbitrary documents ...

Author: Andrzej Hunt <andrzej.hunt@collabora.com>
Date:   Thu Jun 12 17:38:10 2014 +0100
    Implement LibreOfficeKit gtk+ viewer widget.

    Very basic, but works.

June 2015

● Initial preview from
Pranav @ Collabora

mailto:andrzej.hunt@collabora.com
https://pranavk.me/open-source/initial-preview-of-libreoffice-integration-with-gnome-documents/


Online & LibreOffice – IceWarp ...
March 2015 → IceWarp

● Investment into creating alternatives → LibreOffice Online

● “IceWarp and Collabora will work alongside over a thousand existing LibreOffice 
contributors to implement the whole online editing portion of the software, 
including the server-side provided by LibreOffice, and the client front-end based 
on HTML5 technology.”

● IceWarp → exited LibreOffice Jan 2017

Dec 2015 → ownCloud – partnership around CODE/COOL

July 2016 → Nextcloud – partnership



Online & LibreOffice – Progress
Nov 2016 – CODE 2.0

● Collaborative Editing ! …

● ownCloud, Nextcloud, Pydio supporting …

Dec 2017 – CODE 3.0

● Brings full-feature (pixel based) dialogs to the web client

● “Format → Paragraph” etc.

Feb 2019 – CODE 4.0

● HiDPI support, prettier-toolbars, shape insert/edit, basic mobile support



Online & LibreOffice – iOS
Nov 2019 – Collabora Office on iOS

● First version of mobile / tablet UX for iOS

● For the first time there is a free / open source office suite available on iOS:
Collabora Office, thanks to the efforts led by Adfinis SyGroup and Collabora. 

● re-built from scratch with Online

Mar 2019 – Unipoll

● Becomes clear existing thread-heavy model is
un-debuggable & un-maintainable.

● I have to substantially re-write this on the brink of release.
Now – 1 thread per doc in coolwsd, and Kit.

https://www.collaboraoffice.com/release-news/collabora_office_first_free_open_source_office-app_for_ios/


Online & LibreOffice – Android
Dec 2019 - CODE 4.2

● Sidebar chart functions, formula wizard, new theming, icons,
in-line table editing handles, TOC support

Dec 2019 – Collabora Office for Android (Beta)

● Shared / responsive UI with Online & iOS versions

● Based on a completely refreshed approach:

● no Fennec, little Java, a Web-view to a local coolwsd – as per iOS 

https://www.collaboraoffice.com/release-news/collabora-office-android-beta/


Online & LibreOffice – android app#1
Dec 2020 – TDF Android app dropped from Google Play

● On 01/04/2020 10:04, Mike Saunders wrote:

> As you probably know, we quietly removed LibreOffice Viewer from the

> Play Store before Christmas, as its reviews were really bad and it

> hadn't been updated since April 2018. We talked about is here on the

> mailing list, but didn't make a big public communication about it.

Since had some maintenance:

● Android/ since Dec 2020 → 128 commits

● 118 – Michael Weghorn …



Online & LibreOffice – Board vote
[board-discuss] Public agenda for TDF board meeting on Friday, May 22nd at 1300 Berlin 
time (UTC+2)

● Inform/Discuss: Ecosystem & Sustainability (Michael & Thorsten, All 15min)
● Board wants to be more transparent about decisions

● that is good, but we need to publish more data.
● please listen, absorb - everything we say will be

in the minutes or published later:
● questions / challenges possible at the end. … …
● subsequently picked up by theregister (in an unfortunate way)

● Voting on proposal of Paolo:  (Paolo, Board members 15 minutes)



Why buy COOL in 2020-05
Common to Collabora Office:

● Support, SLA, Product Management etc.

LibreOffice Online & CODE → remind large users

Access to stable Binaries – cf. RedHat Enterprise Linux

● Were LibreOffice Online dev snapshot images – but not stable.

Docker images & docker img. build instructions

Collabora install/setup/scaling documentation



Online & LibreOffice – Paolo’s vote:
“Enable the infrastructure team to deliver the following packages with TDF and 
LibreOffice branding:

● docker images

● ownCloud connector (from which we have already got confirmation of acceptance) 
for LOOL

● once that is in place I will ask NextCloud for the opportunity to do the same

● Univention marketplace packages for LOOL

● all packages and connectors will be maintained and updated on a monthly basis 
unless urgent patches/bug fixes are required sooner

● the latest stable version of LOOL code will be used to build the images

...”



Advice from “Open Sources”
Bob Young – Founder of RedHat (sold for $34 billion)

“How Do You Make Money in Free Software”:

"No one expects it to be easy to make money in free software. While making 
money with free software is a challenge, the challenge is not necessarily 
greater than with proprietary software. In fact you make money in free 

software exactly the same way you do it in proprietary software: by building a 
great product, marketing it with skill and imagination, looking after your 

customers, and thereby building a brand that stands for quality and
customer service."



Marketing & Branding is key
The basics:

● Marketing generates Leads → Sales sell to Leads → Money … → make FLOSS

● Lead flow is fundamental to business

● Hunting / Marketing – also possible:

● conferences, direct-mail, etc. → don’t work well. 
read more in my epic on vendor neutral marketing

Marketing vs. our code as “Free as in Beer”

● Using the very well known community brand
is excessively hard.

https://meeksfamily.uk/~michael/data/vendor-neutral-marketing.html


Online & LibreOffice – Paolo’s vote:
“Enable the infrastructure team to deliver the following packages
   with TDF and LibreOffice branding

…

● LibreOffice branded documentation/help files should be created to make it as easy as possible 
to install docker images/Univention packages

● TDF's LOOL packages will be free and supported only by the community.
No paid/support options will be made available by TDF

● In the download page it will be made clear that if LOOL is used in enterprise environment 
support options are available through the members of TDF's ecosystem

● At a later stage eventual limitations in terms of concurrent users/documents will be discussed.”

Vote pulled at the last minute … explanations for that differ.



Marketing plan ...
Before doing this: create a marketing plan

● Reasonable idea → if TDF crushes lead flow

● Idea:  replace it with something
Leads

Leads Leads

From

To ?

2020:



October 2017 – Rome

Collabora 
recruited
Kopano – 
implemented lots 
of changes for 
them,

For a time they 
were listed ahead 
of Collabora in 
the TDF Online 
page.

no sustained 
contribution.



Marketing Plan …
Sticking points:

● Where do the leads go ?

● How do we make that fair ?

● What legal risks does this create for TDF ?

When to start doing it ?

● Should we see if this works before trying it for Online ?

● Or should we just believe it works !?

Try it for LibreOffice Desktop – Moral suasion:

● ‘Home’ → ‘Personal’ → ‘Community’ – watered down / removed Help→About ...



Destroying business confidence
is easy. Creating it is hard.

Imagine you had invested your
entire life’s earnings here.



Online & LibreOffice – the Move
Sep 2020 – CODE 6.4 – using LibreOffice versioning

● Notebookbar, PDF annotations, etc.

1st Oct 2020 → an Online move

   This is primarily a change of presentation, that can un-pick a 
big knot of badness in the LibreOffice community. It is primarily 
driven by the need for continued investment in Online, in 
addition to the huge effort that Collabora and our partners 
have put into the product to date.

        In our view it is the best solution for both LibreOffice and 
Collabora. If the move is handled sensibly we can look forward 
to a bright and co-operative future.

https://www.mail-archive.com/board-discuss@documentfoundation.org/msg04727.html


Why buy COOL post move
Common to Collabora Office:

● Support, SLA, Product Management etc.

Access to stable Binaries – cf. RedHat Enterprise Linux vs. Fedora

● CODE binaries are publicly available … COOL not.

Changed to now public:

● Documentation & Docker images

● Binaries that can be used at scale

Lead generation done via brand awareness ...



Online & LibreOffice – the freeze
Dec 2020 1st (+2 months) – LibreOffice Online frozen

● no commits since the Move (or Fork?)

● A split vote – Chair’s casting vote carried it.

Mar 2022 – Atticization process approved

“The “attic” is a special area of TDF's infrastructure where part of the 
code/documentation/translations, which is not being actively developed, can be stored.”

“A part of the project that is actually present inside the “attic” can be moved back into 
active development, whenever sufficient interest around the code emerges.”

“A sufficient number of developers … each 5-10 non-trivial commits over the span of at 
least three months … Once clearance has been granted, both ESC and BoD will vote etc.”



Online & LibreOffice – atticization
ESC 2022-06-02

● “Heads up on Atticization proposal

  + proposal would be to think about this for a week (Miklos)

     + formal vote next week.“

ESC 2022-06-09

● Discussed – security issues, no contributions, clear path to de-atticize etc.

● ESC vote (very rare) - +9 no concerns, 6 abstain → passed.

July 2022 – Board Decision: Delayed atticization for LibreOffice Online

● “the board resolves to postpone formally atticizing Online for three more months. Unless the de-atticization 
requirements [1] (3 different developers contributing non-trivially) are fulfilled by then, and/or if necessary 
binding corporate commitments are not made by 2022-10-01, Online will be automatically moved to the attic.”

● Result of vote: 2 approvals, 3 abstain, 1 disapproval.



Online & LibreOffice - freeofficeonline
Andreas Mantke’s 

● 2022-06 E-mail “Work on Updated LOOL”
● “freeofficeonline” git repo on github.

● Took Collabora Online repo from June 2022

+20 months of feature work from the COOL team
● 1st commit: add “This file is part of the LibreOffice project.” to all headers [!]

● Renamed a number of files COOL → LOOL
● changed some strings

● Continued to take COOL commits – tweak, and merge.

Silliness around breaking iOS / webkit & presentations in core.



Online & LibreOffice - OxOffice
OSSII have long had their own fork of LibreOffice & LOOL

● Good: building their own brand.

● Hard: tracking code-base: checkout/change /create new repo / check-in

Who wrote 
what ?



Online & LibreOffice – framing...
A maximally unfair & polarizing framing:

● “Collabora ‘stole’ Online from TDF”

● Theft metaphor familiar from eg. “Taking the credit”

We invested a fortune in writing FLOSS

● We contributed it & worked together with others

● When pushed into a corner – we left: TDF is a community project

● People need to want to be here.

Lets get real:

● Others take our code, remove our names / credit, contribute little new of value.

● And also try to use the community brand to kill our lead-flow → business ...



We did do something useful
during COVID !?
What changed with the move:

● Unlimited, easy-to install binary builds: packages, docker images.

● Detailed public setup & install documentation

● Removed this warning:

Collabora helped many schools,
universities, companies

● They continue to fund development
today → thank you to them!

TDF can & could still help of course [!]



Online & LibreOffice – a footnote ...
Footnote: LibreOffice rocks

In case people got confused, it is worth saying that LibreOffice is an outstanding piece of software, 
produced as part of a wonderful, wide community by some of the best developers, translators, 
documentors, etc. you're likely to ever meet. We see LibreOffice as having as a bright future in two ways:

1. as a great, rich desktop & laptop product (as now)

2. as a core LibreOffice technology - provided via LibreOfficeKit and UNO APIs - as a re-usable piece of 
Office awesomeness that can be built on by other projects and companies like Collabora, CIB, and many 
others to build new & valuable products.

We commend it to you, if you’ve not tried before why not:
https://www.libreoffice.org/community/get-involved/

https://www.libreoffice.org/community/get-involved/


LibreOffice Technology ...
Sep 2021 – Italo’s:

● “LibreOffice Technology, a FOSS platform for personal productivity”

● An extremely helpful way of presenting the
joint synergy & goodness here:

● Good community crediting.



Crediting LibreOffice Technology

● Help → About 



Community Credits

https://www.collaboraoffice.com/community-lot/


Online & LibreOffice – a history
Nov 2021 – CODE 21.11

● Based on LibreOffice 7.1 + back-ports

● Sidebar re-write using JSON description of dialogs

● Async save, much faster multi-user editing, 

● New year-based versioning

June 2022 – CODE 22.05

● Based on LibreOffice 7.3 + back-ports

● Released with new formula bar, Delta compression,
a11y check, content-controls, jumbo-sheets, spark-lines etc.



Online & LibreOffice – Nextcloud
Nov 2021 - Nextcloud Office

● LibreOffice Technology as default:
● But the highlight of this release is Nextcloud Office, our now standard office 

suite, developed in collaboration with Collabora Productivity!
● Our goal was to supercharge office in Nextcloud, bringing deeper integration 

than ever before. We have been working on this with a shared team with 
Collabora Productivity and Nextcloud Office will be the default office suite in 
Nextcloud.

● Ongoing joint work on UX & improvement

https://nextcloud.com/blog/nextcloud-hub-2-brings-major-overhaul-introducing-nextcloud-office-p2p-backup-and-more/


Marketing Plan retrospective
Are you on tdf-internal: you should be:

● E-mail: “Marketing Plan – a numerical update”

  “ So: the interesting question is: what is the impact of that change in sales on the ground ? I 
was curious - since even though the brand change and moral suasion was diluted to something 
very weak - there were also changes to the LibreOffice website to encourage business-folk to 
think of using a supported version. Thanks to Mike & Italo for their work there.”

    “The data is now in; of course enterprise sales cycles take a while - but after a year+ we 
should see an impact I hope.”
    “In the relevant time period we haven't significantly changed lots of the variables:”

    “I don't notice any change in 2021-02. Nor when 'fresh' became 'still' (and thus Community 
branded) later that year in 2021-08.”

    “That's sad. “

● Not obvious what to do about that ...



Where to go next ?



Improve the status quo:
Free as in beer concerns:

● Hungry school-kids in Africa need free binaries

● They can use CODE – TDF does.
● Or: Collabora can support – just ask:

● Educational pricing – 25% already
● joint programme ? Go up the chain:

● Needs hardware – and Nextcloud/ownCloud etc.
● Clearly someone needs to pay something → how do we mediate / manage that ?

Strategic accounts:

eg. a Trustee’s local school ?

Some process ?



A calmer world post-atticization ?
Better joint promotion of LibreOffice Technology

● Collabora love LibreOffice – Welcome dialogs etc. … ?

● We like to promote the brand, the technology, tell people about it

Need clear legal rules on that

● Credible, trustworthy & enduring commitments are hard here ...

● Binding future boards is hard – boards agreeing is hard etc.

Love the TDF marketing team:

● We can work more closely – case studies / etc.

● Collabora is a LibreOffice success story – there can be more.



Other thoughts ?
Perhaps: A new and more effective marketing plan ?

● Do we want to re-open this can of worms ?

● Try to persuade the Desktop users that more of them should pay ?

● Use the experience to drive Online development ?
● A massive up-hill struggle

● Not clear the plan works
● Not clear that TDF is a good foundation

to build a business on cf – CIB experience.

Perhaps: Take the hit, badly hurt our developer-base, but … ?

● Give Free as in Beer – LibreOffice branded software away ! Now !



Thanks & Discussion

by Michael Meeks

“Although we are capable of great acts of kindness, history teaches us that we
 sometimes need saving from ourselves - from our recklessness or our greed.

God sent into the world a unique person - neither a philosopher nor a general,
important though they are, but a Saviour, with the power to forgive.” - Elizabeth II, 2011

What in common?: Sun, Oracle, Smoose, SUSE, CloudOn, IceWarp, Kopano

https://www.bbc.com/news/uk-16328899
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